Chapter 375

Mixed Models Tests for the Slope Difference in a 3-Level Hierarchical Design with Random Slopes (Level-3 Randomization)

Introduction

This procedure calculates power and sample size for a three-level hierarchical mixed model which is randomized at the third level. The goal of the study is to compare two group slopes. If the group means are identical at the beginning of the study (which they often are in a randomized trial), testing the difference in slopes is equivalent to testing the difference in means at the end of the study. This is a test of the time-by-treatment interaction.

The study is assumed to be longitudinal in that the third level is some type of cluster (e.g., clinic or hospital), the second level is subjects nested within the third level, and the first level is a repeated measurement at equally-spaced time points on the subjects. Ahn, Heo, and Zhang (2015) call this a longitudinal cluster randomized design.

The data are analyzed by considering the average trend of responses over time. These trends can be considered as random (this procedure) or fixed (a companion procedure).

Randomization

Different models are used depending on how subjects are assigned to the intervention (treatment) groups. This procedure assumes that all subjects (level-2 units) in a cluster (level-3 unit) are assigned to an intervention group at random. This is called level-3 randomization. A companion procedure analyzes the case when subjects are individually randomized to one of the two groups (level-2 randomization).
Fixed or Random
The subject-specific slopes of responses across the repeated measurements can be assumed to be fixed or random. In this random case, each subject is assumed to have a unique slope. These slopes follow an approximate distribution. Their variation is accounted for in the calculations.

Technical Details
Our formulation comes from Ahn, Heo, and Zhang (2015), chapter 6, section 6.4.1.2, page 203-206. The hierarchical mixed model used for the analysis is

\[ Y_{ijk} = \beta_0 + \xi X_{ijk} + \tau T_{ijk} + \delta X_{ijk} T_{ijk} + u_i + u_{j(i)} + v_{j(i)} T_{ijk} + e_{ijk} \]

where

- \( Y_{ijk} \) is the continuous response of the \( k \)th level-1 unit of the \( j \)th level-2 unit of the \( i \)th level-3 unit.
- \( X_{ijk} \) is an indicator variable that is 1 if \( ijk \)th unit is in group 1 and 0 if it is in group 2.
- \( T_{ijk} \) is an integer that represents the time period. We assume that \( T_{ijk} = T_k \) and that these time values increase from 0 (baseline measurement) to \( M - 1 \) (final measurement).
- \( \beta_0 \) is the overall fixed intercept.
- \( \xi \) is the intervention effect at baseline.
- \( \tau \) is the slope of the time effect.
- \( \delta \) is the treatment effect of interest. It models the difference between the two group slopes.
- \( u_i \) is the level-3 random intercept effect for the \( i \)th level-3 unit. It is distributed as \( N(0, \sigma_3^2) \).
- \( u_{j(i)} \) is the level-2 random intercept effect for the \( j(i) \)th level-2 unit. It is distributed as \( N(0, \sigma_2^2) \).
- \( v_{j(i)} \) are the subject-specific random slopes. Their distribution is \( N(0, \sigma_\tau^2) \).
- \( e_{ijk} \) is a random error term which is distributed as \( N(0, \sigma_e^2) \).
- \( \sigma^2 \) is the variance of \( Y_{ijk} \), where \( \sigma^2 = \sigma_e^2 + \sigma_2^2 + \sigma_3^2 \).
- \( \rho \) is the correlation among level-1 units which are in a particular level-2 unit. For fixed models like this, \( \rho = Corr(Y_{ijk}, Y_{ijk'}) = (\sigma_2^2 + \sigma_3^2)/\sigma^2 \).
- \( r_\tau \) is ratio of two variances: \( r_\tau = \sigma_\tau^2/\sigma^2 \).
- \( C_1 \) is the number of level-3 units (clusters) assigned to group 1.
- \( C_2 \) is the number of level-3 units assigned to group 2.
- \( K \) is the number of level-2 units (subjects) per level-3 unit.
- \( M \) is the number of level-1 units per level-2 unit, i.e., the number of repeated measurements.

The test of significance of the \( X_{ijk} T_{ijk} \) interaction term in the mixed model is the test statistic of interest. It tests the difference of the two slopes.

The power can be calculated using

\[
\text{Power} = \Phi \left( \frac{\delta}{\sigma} \sqrt{\frac{C_2 K M \text{Var}(T)}{\left( f_3 + r_\tau M \text{Var}(T) \right)(1 + \frac{1}{\lambda})}} - \Phi(1 - \alpha/2) \right)
\]

where \( \lambda = C_1/C_2 \), \( f_3 = 1 - \rho \), and \( \text{Var}(T) = (M - 1)(M + 1)/12 \).
Procedure Options

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab

The Design tab contains most of the parameters and options that you will be concerned with.

Solve For

This option specifies the parameter to be solved for from the other parameters. The parameters that may be selected are $\delta$, Power, $C_1$, and $K$.

Under most situations, you will select either Power to calculate power or $C_1$ to calculate the number of level-3 unit. Occasionally, you may want to fix $C_1$ and $C_2$ and calculate $K$.

Note that the value selected here always appears as the vertical axis on the charts.

The program is set up to calculate power directly. To find appropriate values of the other parameters, a binary search is made using an iterative procedure until an appropriate value is found. This search considers only integer values of $C_1$, $K$, or $M$.

Power and Alpha

Power

This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null hypothesis is not rejected.

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 0.90 (Beta = 0.10) is also commonly used.

A single value may be entered or a range of values such as 0.8 to 0.95 by 0.05 may be entered.

If your only interest is in determining the appropriate sample size for a confidence interval, set power to 0.5.

Alpha

This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true null hypothesis is rejected.

Values must be between zero and one. Usually, the value of 0.05 is used for alpha and this has become a standard. This means that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents the risk of a type-I error you are willing to take in your experimental situation.

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.
Sample Size

C1 (Level 3 Units Assigned to Group 1)
This is the number of level 3 units (clusters) in group 1 (treatment group). The sample size for this group is equal to Ceiling(C1 * K * M).

Examples of level 3 units are practices, clinics, hospitals, or doctors.

A longitudinal study might include clinics as the level 3 units, patients as the level 2 units, and repeated measurements are the level 1 units.

This value must be a positive integer.

You can enter a list of values such as "10 20 30". A separate analysis will be run for each element in the list.

C2 (Level 3 Units Assigned to Group 2)
This is the number of level 3 units (clusters) in group 2 (control group). The sample size for this group is equal to Ceiling(C2 * K * M).

Examples of level 3 units are practices, clinics, hospitals, or doctors.

A longitudinal study might include clinics as the level 3 units, patients as the level 2 units, and repeated measurements are the level 1 units.

This value must be a positive integer.

Using Multiples of C1
If you simply want a multiple of the value for group 1, you would enter the multiple followed by "C1", with no blanks. If you want to use C1 directly, you do not have to enter the leading "1". For example, all of the following are valid entries:

C1 2C1 0.5C1 1.5C1.

You can use a list of values such as "10 20 30" or "C1 2C1 3C1".

K (Level 2 Units Per Level 3 Unit)
This is the average number of level 2 units in each level 3 unit. Examples of level 2 units are subjects or patients.

A longitudinal study might include clinics as the level 3 units, patients as the level 2 units, and repeated measurements are the level 1 units.

This value must be a positive number that is at least 1.

It can be a decimal (fractional) number such as '2.7'. The resulting total number of level 1 units will be rounded up to the next largest integer.

You can use a list of values such as "5 10 15". A separate analysis will be run for each element in the list.

M (Level 1 Units Per Level 2 Unit)
This is the average number of level 1 units in each level 2 unit. Examples of level 1 units are repeated measurements.

A longitudinal study might include clinics as the level 3 units, patients as the level 2 units, and repeated measurements are the level 1 units.

This value must be a positive number that is at least 1.

It can be a decimal (fractional) number such as '2.7'. The resulting total number of level 1 units will be rounded up to the next largest integer.

You can use a list of values such as "5 10 15". A separate analysis will be run for each element in the list.
**Effect Size**

**Slope Input Type**
Select the input type for entering the difference in slopes. Two options are available: \((\mu_1 - \mu_2)\) and \(\delta\).

- **\(\mu_1 - \mu_2\) (Mean Difference)**
  Enter the difference in means at the final time point. The difference in slopes will then be calculated from this value. This option is provided because this is a value that can be easily interpreted and should be readily available.

- **\(\delta\) (Slope Difference)**
  Enter values for \(\delta\) directly. This option requires you to determine appropriate values for \(\delta\) which will often be difficult.

**\(\mu_1 - \mu_2\) (Mean Difference)**
Enter one or more values for the mean difference where \(\mu_1\) is the mean of group 1 at the final measurement and \(\mu_2\) is the mean of group 2 at the final measurement. This mean difference is used to calculate the difference in slopes (\(\delta\)) using the formula:

\[
\delta = (\mu_1 - \mu_2) / (M - 1).
\]

This formula comes from the group-by-time interaction term in the mixed model which is \(\delta XT\). Here, \(X\) indicates whether the subject is a member of group 1 or not, and \(T\) is the time. Since this procedure assumes that the times are 0, 1, 2, ..., \((M-1)\), the value of \(T\) at the last measurement point is \((M-1)\). Thus, \(\delta XT = \delta X(M-1)\) at the last time point. This leads to the above formula.

The subject slopes are assumed to be random from a normal distribution with different group means.

The power is the probability of detecting a \(\delta\) of at least this amount. This value is not necessarily the true difference. Rather, it is the difference you want to detect.

The difference, \(\mu_1 - \mu_2\), can be any non-zero value (positive or negative). Since this procedure uses a is a two-sided test statistic, you will get the same result with either positive or negative values.

**Syntax**
You can enter a single value such as 1 or a series of values such as 1 2 3 or 1 to 2 by 0.2.

When a series of values is entered, PASS will generate a separate calculation result for each value of the series.

**\(\delta\) (Slope Difference)**
Enter one or more values for \(\delta\) which is the difference between the group 1 and 2 slopes of the outcome over time. This difference equates to the difference in means at the final measurement if the means at the first measurement are equal (which is often the case for randomized trials).

The formula of the relationship between the group means at the final measurement is \((\mu_1 - \mu_2) = \delta (M - 1)\).

The slopes of the measurements across time are assumed to be a random. These slopes are distributed normally with different mean slopes for the two groups. The power is the probability of detecting a difference of at least this amount between the two average slopes. This value is not necessarily the true difference. Rather, it is the difference you want to detect.

Range: \(\delta\) can be any non-zero value (positive or negative). Since this procedure uses a is a two-sided test statistic, you will get the same result with either positive or negative values.

You can enter a single value such as 1 or a series of values such as 1 2 3 or 1 to 2 by 0.2. When a series of values is entered, **PASS** will generate a separate calculation result for each value of the series.
Enter the standard deviation of an individual observation, $Y_{ijk}$. This standard deviation applies for both groups.

Note that $\sigma$ must be a positive number. You can enter a single value such as 5 or a series of values such as 1 3 5 7 9 or 1 to 9 by 2.

Press the small ‘$\sigma$’ button to the right to obtain calculation options for estimating the standard deviation.

$\rho$ (Within Subject Correlation)

This is the correlation of each pair of repeated measurements within a subject.

Possible values are from 0 to just below 1. Typical values are between 0.0001 and 0.5.

You may enter a single value or a list of values.

$r_T$ (Random Slope Variance/$\sigma^2$)

Enter the ratio of the variance of subject-specific, random slopes to the sum of the other variances, $\sigma^2$.

Possible values range from 0 (for a fixed-slope model) to any positive value.

You can enter a single value such as 0.1 or a series of values such as 0.1 0.2 0.3 or 0.1 to 1 by 0.1.

When a series of values is entered, PASS will generate a separate calculation result for each value of the series.
Example 1 – Calculating Power

Suppose that a three-level hierarchical design is planned in which repeated measurements (level-1) will be taken on subjects (level-2) within hospitals (level-3). This analysis will calculate the power for detecting the difference in slopes of two interventions.

The following parameter settings are used for the power analysis: $\mu_1 - \mu_2 = 2.4$; $\sigma = 2.6$; $r_T = 0.1$; $\rho = 0.1$; $K = 4$; $M = 4, 5$; $\alpha = 0.05$; and $C_1 = C_2 = 10, 15, 20, 25$.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Mixed Models Tests for the Slope Diff. in a 3-Level Hier. Design with Random Slopes (Level-3 Rand.) procedure window. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>C1 (Level 3 Units Assigned to Group 1)</td>
<td>10 15 20 25</td>
</tr>
<tr>
<td>C2 (Level 3 Units Assigned to Group 2)</td>
<td>C1</td>
</tr>
<tr>
<td>K (Level 2 Units Per Level 3 Unit)</td>
<td>4</td>
</tr>
<tr>
<td>M (Level 1 Units Per Level 2 Unit)</td>
<td>4 5</td>
</tr>
<tr>
<td>Slope Input Type</td>
<td>$\mu_1 - \mu_2$ (Mean Difference)</td>
</tr>
<tr>
<td>$\mu_1 - \mu_2$ (Mean Difference)</td>
<td>2.4</td>
</tr>
<tr>
<td>$\sigma$ (Standard Deviation)</td>
<td>2.6</td>
</tr>
<tr>
<td>$\rho$ (Within Subject Correlation)</td>
<td>0.1</td>
</tr>
<tr>
<td>$r_T$ (Random Slope Variance / $\sigma^2$)</td>
<td>0.1</td>
</tr>
</tbody>
</table>

Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Power</th>
<th>Total</th>
<th>N</th>
<th>C1</th>
<th>C2</th>
<th>K</th>
<th>M</th>
<th>Mean Diff</th>
<th>Std Dev</th>
<th>Level 1 Corr</th>
<th>V(βi) / $\sigma^2$</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.7391</td>
<td>320</td>
<td>10</td>
<td>10</td>
<td>4</td>
<td>4</td>
<td>2.40</td>
<td>2.60</td>
<td>0.100</td>
<td>0.100 0.100 0.050</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.6582</td>
<td>400</td>
<td>15</td>
<td>15</td>
<td>4</td>
<td>5</td>
<td>2.40</td>
<td>2.60</td>
<td>0.100</td>
<td>0.100 0.100 0.050</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.8897</td>
<td>480</td>
<td>15</td>
<td>15</td>
<td>4</td>
<td>4</td>
<td>2.40</td>
<td>2.60</td>
<td>0.100</td>
<td>0.100 0.100 0.050</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.8263</td>
<td>600</td>
<td>15</td>
<td>15</td>
<td>4</td>
<td>5</td>
<td>2.40</td>
<td>2.60</td>
<td>0.100</td>
<td>0.100 0.100 0.050</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.9571</td>
<td>640</td>
<td>20</td>
<td>20</td>
<td>4</td>
<td>4</td>
<td>2.40</td>
<td>2.60</td>
<td>0.100</td>
<td>0.100 0.100 0.050</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.9175</td>
<td>800</td>
<td>20</td>
<td>20</td>
<td>4</td>
<td>5</td>
<td>2.40</td>
<td>2.60</td>
<td>0.100</td>
<td>0.100 0.100 0.050</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.9843</td>
<td>800</td>
<td>25</td>
<td>25</td>
<td>4</td>
<td>4</td>
<td>2.40</td>
<td>2.60</td>
<td>0.100</td>
<td>0.100 0.100 0.050</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.9628</td>
<td>1000</td>
<td>25</td>
<td>25</td>
<td>4</td>
<td>5</td>
<td>2.40</td>
<td>2.60</td>
<td>0.100</td>
<td>0.100 0.100 0.050</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

References

Report Definitions
Power is the probability of rejecting a false null hypothesis. It should be close to one.
N is the total number of level-1 units.
C1 and C2 are the number of level-3 units assigned to groups 1 and 2, respectively.
K is the average number of level-2 units per level-3 unit.
M is the average number of level-1 units per level-2 unit.
μ1 - μ2 is the difference in the two group means at the final measurement time: $\delta = (\mu_1 - \mu_2) / (M - 1)$.
σ is the standard deviation of the level-1 responses.
ρ is the correlation among level-1 units in a particular level-2 unit.
$r_T$ is ratio of the subject-specific slope variance to $\sigma^2$.
Alpha is the probability of rejecting a true null hypothesis, that is, rejecting when the means are actually equal.

Summary Statements
The total sample size of 320, which were obtained from 10 level-3 units in group one and 10 level-3 units in group two with an average of 4 level-2 units per level-3 unit and 4 level-1 units (repeated measurements) per level-2 unit, achieves 74% power to detect a difference between the (random) group means at the last time of 2.40. The standard deviation of level-1 units is 2.60. The correlation of level-1 units within a level-2 unit is 0.100. The ratio of the subject-specific slope variance to $\sigma^2$ is 0.100. A test based on a mixed-model analysis is anticipated at a significance level of 0.050.

This report shows the power for each of the scenarios.

Plots Section
These plots show the power versus the level-3 count for the two values of M.
Example 2 – Calculating Sample Size (Number of Clusters)

Continuing with the last example, suppose the researchers want to determine the number of clusters needed to achieve 90% power for the values of M.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Mixed Models Tests for the Slope Diff. in a 3-Level Hier. Design with Random Slopes (Level-3 Rand.) procedure window. You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab Solve For ...........</td>
<td>C1 (Number Level 3 Units in Group 1)</td>
</tr>
<tr>
<td>Power ..........................</td>
<td>0.90</td>
</tr>
<tr>
<td>Alpha ..........................</td>
<td>0.05</td>
</tr>
<tr>
<td>C2 (Level 3 Units Assigned to Group 2)</td>
<td>C1</td>
</tr>
<tr>
<td>K (Level 2 Units Per Level 3 Unit)</td>
<td>4</td>
</tr>
<tr>
<td>M (Level 1 Units Per Level 2 Unit)</td>
<td>4 5</td>
</tr>
<tr>
<td>Slope Input Type ................</td>
<td>μ1 - μ2 (Mean Difference)</td>
</tr>
<tr>
<td>μ1 - μ2 (Mean Difference) .....</td>
<td>2.4</td>
</tr>
<tr>
<td>σ (Standard Deviation) .........</td>
<td>2.6</td>
</tr>
<tr>
<td>ρ (Within Subject Correlation)</td>
<td>0.1</td>
</tr>
<tr>
<td>rT (Random Slope Variance / σ²)</td>
<td>0.1</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Numeric Results for a Three-Level Hierarchical Mixed Model</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Std Dev Mean Diff Level 1 Std Dev Level 1 Corr  V(βi) σ² Alpha</td>
</tr>
<tr>
<td>0.9038 2.40 2.40 19 19 4 4</td>
</tr>
<tr>
<td>0.9081 2.40 2.40 16 16 4 4</td>
</tr>
</tbody>
</table>

This report shows the power for each of the scenarios.
Example 3 – Validation using Ahn, Heo, and Zhang (2015)

Ahn, Heo, and Zhang (2015) page 207 provide a table in which several scenarios are reported. We will validate this procedure by the first row of the table. The following parameter settings were for the analysis: power = 0.80; δ = 0.3; σ = 4; ρ = 0.1; rT = 0.1; K = 8; M = 5; and α = 0.05. These settings resulted in a value of C2 (their N_1^{(0)}) of 67 and an attained power of 0.804.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Mixed Models Tests for the Slope Diff. in a 3-Level Hier. Design with Random Slopes (Level-3 Rand.) procedure window. You may then make the appropriate entries as listed below, or open Example 3 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>C1 (Number Level 3 Units in Group 1)</td>
</tr>
<tr>
<td>Power</td>
<td>0.8</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>C2 (Level 3 Units Assigned to Group 2)</td>
<td>C1</td>
</tr>
<tr>
<td>K (Level 2 Units Per Level 3 Unit)</td>
<td>8</td>
</tr>
<tr>
<td>M (Level 1 Units Per Level 2 Unit)</td>
<td>5</td>
</tr>
<tr>
<td>Slope Input Type</td>
<td>δ (Slope Difference)</td>
</tr>
<tr>
<td>δ (Slope Difference)</td>
<td>0.3</td>
</tr>
<tr>
<td>σ (Standard Deviation)</td>
<td>4</td>
</tr>
<tr>
<td>ρ (Within Subject Correlation)</td>
<td>0.1</td>
</tr>
<tr>
<td>rT (Random Slope Variance / σ²)</td>
<td>0.1</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

PASS calculates the same values of C2 and power: 67 and 0.804.